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Operating Instructions for PhyTip® MEA 
Personal Purification System 
 
 
 
 Introduction 
 
 
In order to extend the benefits of PhyTip® columns for protein purification and 
enrichment, PhyNexus has developed the PhyTip® MEA Personal Purification System as 
the platform of choice for fully automated protein purification and enrichment. When 
used with the PhyNexus Operating Software, this system offers a range of flow rates that 
maximizes the purification and enrichment efficiency of the various affinity resins 
available for PhyTip® columns. In combination with the fully programmable positioning 
of the 12 channel system, and the ability to place samples, PhyTip® columns, wash 
stations and elution plates in any available position, the MEA Personal Purification 
System is an ideal automated system for micro scale protein purification. 
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Section A 
 
 
1. Unpacking 
 
Each MEA system contains the following: 
 

1. MEA Purification System 
2. Two power supplies (one for MEA, one for 12 channel system). Use only the 

power supplies provided, see page 73 for ratings.  
3. ME 12 channel system(s). The 12 Channel system(s) will be provided with 

attachment clamp already installed, ready to attach to the robotics tower. 
4. Software CD 
5. Communications cable 
6. Consumables pack including PhyTip Evaporation Covers, Holders and 96-well 

plates 
7. Literature, documents and Operating Instructions pack 
8. Any optional cooling accessories ordered will ship with a third power supply. Use 

only the power supplies provided, see page 73 for ratings.  
 

 
If these separate items are not in the original outer packing, please call PhyNexus Inc, at 
408-267-7214. 
 
Remove all contents from their individual packs and prepare to install the system. 
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2. Setting up the system 
 
This section is divided into: 
 

1. Initial location and set up of system parts 
2. Installing the software 
3. Powering up the system 
4. Cleaning the system 

 
 
1. Initial location and set up of system parts 
 
Quick guide: 
 
Once all contents have been removed from their individual packs, locate the MEA 
instrument and place it close to the computer to be used for operation. Remove the 12 
channel system and attach to the robotics tower using the adaptor. Connect the 
communications cable between MEA COM1 and the computer. Connect the power 
supply to the MEA and separate power supply to the 12 channel system, and if installed, 
connect the power supply to the cooler accessory. Locate the Software CD and install in 
the computer.  
 
Detailed description: 
 
Instrument placement. 
 
Remove the MEA system from its packing box and place on the specified lab bench. This 
must be close enough for two power supplies that are required to operate the MEA 
system (if the optional cooling accessory has been ordered, this will require a separate 
power supply). Enough vertical clearance must be given for the robot tower to move 
along the x axis (maximum height above the bench = 24”), and there must be enough 
space on the right hand side of the instrument to reach/press the red Emergency Stop 
button and the control switch for the cooling option. The surface for the MEA should be 
smooth and flat. 
 
The full instrument dimensions are: 
 
Width:  32” 
Depth:   14”, plus 6” to accommodate all necessary power supplies and cables. 
Height:  24” 
Weight:  55 lbs 
 
Installing the instrument. 
 
Each MEA is shipped with the ordered 12 channel ME system(s), either ME200+ (for 
200+ PhyTip columns that operate with volumes up to 200 µL) or ME1000+ (for 1000+ 
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PhyTip columns that operate with volumes up to 1000 µL) with the alignment clamp 
attached. Remove the ME system from its packing and install this unit onto the receptacle 
on the robot tower as follows: 
 

1. The black alignment clamp has been factory installed on the 12 channel system. 
The LCD on the 12 channel system is at the front of the unit and the clamp has an 
alignment slot at the rear which will interface with an alignment bar on the 
moving Z-head on the robotic tower.  The moving Z-head is a round bar with a 
single flat surface that extends forward of the robotic tower and the alignment bar 
that is parallel to the x axis of the system.  
 

2. Locate the single attachment hole at the rear of the clamp and push the clamp onto 
Z-head bar.  
 

3. With the alignment bar and alignment slot parallel to each other, push the clamp 
mechanism in fully until it snaps in place.  

 
4. Turn the knurled screw on the side of the clamp to finally tighten the clamping 

mechanism in place. 
 
To exchange the 12 channel system, simply loosen the knurled screw, ease the clamp 
from the alignment slot and pull away from the z-head bar. Repeat the first four steps 
with the alternate 12 channel system. 
 
When replacing a 200+ channel system with a 1000+ 12 channel system, remove the 
front and rear retaining bars that are at positions 1 and 2.  There are three allen key 
screws (two at the front and 1 at the rear).  Unscrew the three screws and remove the 
retaining bars.  The new height of positions 1 and 2 will be ready for the deep tip boxes 
used with the 1000+ 12 channel system. 
 
Take the communication cable that is attached to the 12 channel system and route it 
through the cable management channel on the robot track down to the communications 
port at the rear of the MEA (COM2). This is achieved by just pressing the cable into the 
track and snapping it in place. Using a flat head screw driver, attach the communications 
connector to the MEA. 
 
Take the MEA power supply and attach to the supply port on the rear of the MEA 
(labeled “Power”). Take the 12 channel system power supply and attach to the 12 channel 
power supply port that is on the gray communication cable that runs from the top of the 
12 channel system to the MEA. Connect all power supplies to the main voltage line.   
  
Take the separate communications cable and connect between the MEA port COM1 and 
a serial port of the computer to be used. 
 
If the optional cooling accessory has been installed, simply connect the additional power 
supply at the rear of the instrument in the port labeled “Chiller Plate.” 
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Side view of MEA system.  
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Rear view of MEA system showing power supply inlets and cable 
attachment points 
 

Power inlet and On/Off 
switch for cooling 
accessory

Power inlet and On/Off 
switch for MEA system
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2. Install the software in the PC 
 
The PhyNexus Operating Software is designed to operate with PCs running Windows 
XP, 2000, NT, and 98.  With the computer turned on, insert the software disc into the CD 
or DVD drive of the system, double click on the setup icon, and follow the install 
instructions on the screen.  
 
 
 
 
3. Powering up the system 
 
With all power supplies connected and the software installed in the computer, turn the 
system on by pressing the power supply switch at the rear of the MEA. A green “Power 
On” light will illuminate at the front of the instrument. If the green light does not 
illuminate, first check that all connects have been made and secondly make sure that the 
red emergency stop button has not been depressed. To do this, turn the emergency button 
in the direction for Reset (clockwise).  
 
If the optional cooling accessory is installed, turn the main power on by pressing the 
power switch at the rear of the instrument and then turning the setting switch on the right 
of the instrument to the appropriate setting.   
 
4. Cleaning the system. 
 
The MEA Personal Purification System can be cleaned by wiping with a damp cloth. Do 
not use solutions containing high concentrations of bleach or other oxidizing agents.   
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3. Using the PhyTip MEA Purification System 
 
This portion of the manual is divided into the following sections: 
 

1. Setting the instrument deck 
2. Easy to Use Quick Guide Software Instructions 
3. Easy To Use Quick Guide Operating Instructions 
4. Detailed Software Information and Instructions 
 
 

1. Setting the instrument deck 
 
The instrument deck can be configured in a number of different ways, but the standard 
configuration is as follows: On the left there are two positions for Tip boxes and to the 
right of these, there is enough space to hold 5 plates (standard SBS) and one reagent 
reservoir.  
 
Position 1.  PhyTip Box  
Position 2.  PhyTip Box 
Position 3.  Plate position (Plate 1) 
Position 4.  Plate position (Plate 2) 
Position 5.  Plate position (Plate 3) 
Position 6.  Reservoir position 
Position 7.  Plate position (Plate 4) 
Position 8.  Plate position (Plate 5) 
 
If necessary, the positions of these plates can be changed by moving the attached pins and 
replacing them in the appropriate positions. This maintains perfect alignment of each 
plate in each position during MEA operation. 
 
If the MEA has been installed with the PhyTip Cooling Accessory, the accessory will 
require its own power supply. When on, the cooling accessory will maintain the last two 
positions under the deck (Positions 7 & 8) at a temperature of approximately 4-6◦C. This 
temperature can be modified by turning the control knob on the right side of the 
instrument. Position 1 represents the coldest setting and position 5 the warmest setting 
available as demonstrated below:   
 

Position Approximate 
Temperature (°C) 

1 4 
2 8 
3 12 
4 16 
5 20 
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For a standard purification set up: 
 
Position 1: PhyTip Columns – new/unused 
 
For the MEA system, these should only be PhyTip columns with the appropriate part 
numbers for the 12 channel system that is being used, e.g. 200+ or 1000+, and the affinity 
resin that is required e.g. PTR 96-05-01 (Pack of 96 PhyTip columns for the 200+ system 
with Protein A as affinity resin). 
 
Position 2: Empty box for used PhyTip columns 
 
Used PhyTip columns can be replaced in their original box or if required, in a separate 
empty box. 
 
Position 3: Extra plate position 
 
This extra position can be used for a number of different applications e.g. extra wash step 
etc.  
 
Position 4: Wash Plate 1 
 
Depending on the specific application, a number of different types of wash plates may be 
placed in this position, e.g. deep well 96-well plates. Care must be taken when choosing 
the type of deep well 96-well plate. When using the 1000+ system, PhyNexus 
recommends the use of 2 mL, square well plates (PhyNexus Part Number PCP 96-20-10). 
 
Position 5: Wash Plate 2 
 
Depending on the specific application, a number of different types of wash plates may be 
placed in this position, e.g. deep well 96-well plates. Care must be taken when choosing 
the type of deep well 96-well plate. When using the 1000+ system, PhyNexus 
recommends the use of 2 mL, square well plates (PhyNexus Part Number PCP 96-20-10). 
 
Position 6: Reservoir Position 
 
Depending on the application and specific affinity resin used, the Reservoir Position can 
be used as a holder for neutralization buffer. When used in this mode, the reservoir is 
filled with sufficient volume of neutralization buffer. Also Tip box position 2 should be 
used to hold standard Rainin LTS Pipette Tips. The system should then include the 
incorporation of a neutralization step using the Reservoir Position; use PhyNexus 
“reservoir inserts” (PhyNexus Part Number 96-60-00).   The maximum total volume per 
well for each of the reservoir wells is approximately 300 µL, therefore maximum 
recommended volume to be transferred (assuming 8 rows in a full 96-well plate) is 35 
µL.  
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Position 7: Sample Plate (samples to be purified) 
 
Depending on the specific application, a number of different types of sample plates may 
be placed in this position, e.g. deep well 96-well plates. Care must be taken when 
choosing the type of deep well 96-well plate. When using the 1000+ system, PhyNexus 
recommends the use of 2 mL, square well plates (PhyNexus Part Number PCP 96-20-10). 
 
Position 8: Elution Plate 
 
PhyNexus recommends the use of the PhyTip Elution Plates (Part number PCP 96-00-10) 
for the final step of elution. These plates have v-bottoms which maximize the process of 
elution. It is also recommended to cover the plates, once the elution buffer has been 
added, with a PhyTip Plate Cover (Part number PCP 96-10-20) and PhyTip Plate Holder 
(Part number PCP 96-10-50). 
 
With the cooling accessory attached, both positions 7 and 8 can be maintained at sub 
ambient temperatures.  
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2. Easy to use Quick Guide Software Instructions 
 
The Auto controller Operating Software has been designed for simple to use automated 
methods that have been preprogrammed into the system. However, any combination of 
movements and positions can be built into a user defined method. To begin, PhyNexus 
recommends that the user start with the built-in methods and subsequently modify these 
to match the requirements of the application. 
 
Methods manage the entire process of moving the robotics tower with 12 channel system 
attached to perform the Capture, Purify and Enrich process for all of the defined samples, 
Protocols manage the individual steps of the Capture, Purify and Enrich process. A 
method is a series of protocols and robotic movement/position instructions that fully 
automate the entire process of purifying a full plate of 96 samples. To load the software 
onto a PC, simply insert the CD into the CD or DVD drive of the PC and follow the 
installation instructions on the screen.  
 
For simplest use of the system, run the preprogrammed methods for any of the given 
affinity resins. To do this, go to File, then Open. This will bring down a screen that 
shows either Method or Protocol, click on Method to show all of the stored Methods. 
Open the standard method IMAC; this will bring down the operational screen. Now go to 
Method and click on Edit; this will show all of the individual steps of the method. 
 
Click on any one of the individual steps of the methods to show the options screen; this 
will be split into two sections. The top section deals with the operation of the 12 channel 
system (controller), while the bottom section deals with robotics movement of the 
autocontroller. Actions that are available are: 
 
Top Section: 
 
Execute:      executes a stored protocol, e.g. Capture 
 
Audible Alert:           introduces an audible alert at the end of an action 
 
Home (controller):   homes the 12 channel system to a zero volume 
 
Pause for Operator: builds in an automatic pause in the method 
 
Comment:                 allows operator to build in an automatic comment or prompt 
                                  between actions 
 
Blowout:                   causes a 12 channel system to blow out any air from the syringe 
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Bottom Section: 
 
Home Autocontroller: returns the robotics tower and 12 channel system to registered 
                                    Home position 
 
Down:                    moves the robotics tower with 12 channel system down to 
                               designated step position (0 is the highest position above the deck 
                                and 4725 is the position closest to the deck). A dialog box will  
 appear where the number of steps can be entered. 
 
Up:                           moves the robotics tower with 12 channel system up to the 

designated step position (0 is the highest position above the deck 
and 4725 is the position closest to the deck). A dialog box will  

 appear where the data can be entered, if left unchecked the default 
 is all the way up to the zero position. If data is entered, this 

information is only a delta, meaning that if 20 is entered the tower 
will move up 20 positions and NOT to location number 20. 

 
External Pump:       operates an external pump (when fitted) via the rear serial port, 
                                 allowing for the automated addition of reagents.  
 
Rotate:   rotates the vertical 12 channel system (clockwise = 0 to + 335 and 
   Counterclockwise = 0 to – 25)  
 
Sub method:                allows user to define a specific action and store this in memory 
   e.g. “Costar 200+ V bottom plate” could reference the specific z  
                                    height of a novel plate, once stored in memory, z numbers would  
                                    not need to be recalled. 
 

 
  
Position:                   moves the robotics tower with 12 channel system to the desired 
                                 x-axis location on the deck. There are a total of 39,100 positions  
                                 along the x-axis. 
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Position/Row           moves the robotic tower with 12 channel system to the desired  

Position (1-8) and specific Row (1-8).  This command assumes the 
use of plates that have 8 rows (e.g., standard 96 well plates, certain 
48 well plates, etc.). 

 
Load Tips:                   loads a row of 12 PhyTip columns onto the 12 channel system. 
   This also incorporates the function of going down to the tips,  
   loading the tips and moving them out from the tip box. This is set  
                                    for the default PhyTip columns and standard Rainin LTS tips for  
                                    neutralization. 
 
Eject:                         ejects all 12 PhyTip columns from the 12 channel system 
 
XMOV:    Auto movement to specify position along x axis. CAUTION: 
  This action does NOT move tower to zero position.  
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3. Easy to Use Quick Guide Operating Instructions 
 

A. Calibrating the Instrument 
 
Once installed in the correct position the instrument should be recalibrated in order to 
correctly zero the position of the robotic tower. It is also recommended that for each 
pipettor, (200 or 1200) calibration should be checked and stored. 
To access the calibration software go to the general toolbar on the operating software and 
click on Options, this will display Communications, Syringe, Calibration, Manual 
Positioning and SubMethods. Click on Syringe and select either 200 or 1200 (for the 12 
channel system that uses 200+ tips, choose 200: for 12 channel system that uses 1000+ 
tips, choose 1200). Next, click on Calibration, this will now display a screen with 
“Align” and three dialog boxes for x-position, rotation and z-axis.  
 

 
 
Click align, and the 12 channel will move to the zero position on x-axis and then down to 
the normal tip loading height for the specific 12 channel system that is connected e.g. 200 
or 1200. Adjustments can be made for x-axis, z-axis and rotate as follows: 
For the x-axis, adjust the +1 and -1 settings to align the tip holders on the 12 channel 
system in the center of the tips 
For the z-axis, adjust the +1 and -1 settings to bring the base of the tip holders on the 12 
channel system to approximately 2 mm above the top of the tips. 
For the rotation, adjust the +1 and -1 settings to bring the plane of the base of the tip 
holders on the 12 channel system parallel with the plane of the top of the tips. 
Once complete, click Save. This will save the calibration settings for the specific 12 
channel system. The software recognizes the difference between a 200+ system and 
1200+ system and applies the saved settings accordingly. 
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Manual Positioning 
 
This allows the user to position the 12 channel system, anywhere on the deck. This is 
particularly useful when used in conjunction with Sub-method. Care must be taken when 
using this part of the software as the z-axis does not automatically return to a safe height 
above the deck, but instead moves the 12 channel system along the specific z-axis height 
that is seen on the screen. 
 
 

 
  
 

B. Instrument programming 
 

Before programming a specific method note all of the specific steps that are likely to be 
carried out in the process that needs to be accomplished. Below is an example of some of 
the steps involved in a basic Method. 
 

1. Prime the 12 channel system and home. 
2. Move to Row 1 of Box 1 of PhyTip, move robot tower down and pick up row 1 of 

PhyTip columns. 
3. Move robot tower up and the across to row 1 of sample plate at position 3. 
4. Move tower down so that PhyTip columns enter the sample. 
5. Begin preprogrammed Capture Step. 
6. Upon completion of Capture step, bring tower up and move across to row 1 of 

wash plate 1 in plate position 4. 
     7.    Move tower down so that PhyTip columns enter wash buffer 1. 
     8.    Begin preprogrammed Wash 1 Step. 
     9.    Upon completion of Wash step 1, bring tower up and move across to row 1 of  

wash plate 2 in plate position 5.  
10. Move tower down so that PhyTip columns enter wash buffer 2. 
11. Begin preprogrammed Wash 2 Step. 
12. Upon completion of wash step 2, bring tower up and move across to row 1 of 

Enrichment Step in plate position 6. 
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13. Move tower down so that PhyTip columns enter Elution buffer. 
14. Begin preprogrammed Enrichment step. 
15. Upon completion of this step bring tower up and move back to row 1 of the 

original tip box in position 1. Move tower down and discard tips in row 1. 
16. Repeat the process for row 2, etc. 

 
 
The robotics tower is stepper motor driven and as such can be controlled by discrete steps 
in both the X and Z axis. In the Z axis, there are 4,725 steps and in the X axis, there are 
39,100 steps. The robotics head can be driven to any of these steps by entering position 
numbers in the appropriate part of the software. Standard methods, built into the 
software, already have these positions preprogrammed. 
 
To simplify this process the following standard and guidelines will help to speed up the 
process of programming: 
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When using the 200+ 12 channel system: 
 
The simple programming of the software allows the user to move to any position and any 
row. However, to set the height of the tips, use these guidelines: 
 
For z-axis heights in positions 3,4,5,7 & 8 it, is assumed a PhyTip plate is used. 
 
For z-axis heights: 
  
PhyTip columns  
  Load Eject 
Position 1 4210* 4100 
Position 2 - - 
  With cooler Without cooler 
Position 3 4280 4280 
Position 4 4280 4280 
Position 5 4280 4280 
Position 6 - - 
Position 7 4225 4280 
Position 8 4225 4280 

 
Rainin LTS  
  Load Eject 
Position 1 - - 
Position 2 4210* 4100 
  With cooler Without cooler 
Position 3 - - 
Position 4 - - 
Position 5 - - 
Position 6 4070 - 
Position 7 4140 4195 
Position 8 4140 4195 

* This is the initial z setting, then the 12 channel system moves down another 60 into the 
tips. This is for reference only. The system defaults to automatically load tips with the 
“Loadtips” command. The user should NOT program a down 4210 and follow this with a 
“Loadtips” command. 
 
When using the 1000+ 12 channel system: 
 
The simple programming of the software allows the user to move to any position and any 
row. However, to set the height of the tips, use these guidelines: 
 
For z-axis height it is assumed that for positions 3, 4, 5 & 7, a PhyTip Deep Well Plate is 
used, and for position 8, a PhyTip Plate is used. 
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For z-axis heights: 
 
PhyTip columns  
  Load Eject 
Position 1 3600* 3500 
Position 2 - - 
  With cooler Without cooler 
Position 3 2350 2350 
Position 4 2350 2350 
Position 5 2350 2350 
Position 6 - - 
Position 7 2325 2380 
Position 8 2325 2380 

 
Rainin LTS  
  Load Eject 
Position 1 - - 
Position 2 3600* 3500 
  With cooler Without cooler 
Position 3 - - 
Position 4 - - 
Position 5 - - 
Position 6 2050 - 
Position 7 2135 2135 
Position 8 2190 2190 

* This is the initial z setting, then the 12 channel system moves down another 100 into 
the tips. This is for reference only. The system defaults to automatically load tips with the 
“Loadtips” command. The user should NOT program a down 4210 and follow this with a 
“Loadtips” command.  
 
 

B. Reagents 
 
1. Preparing samples ready for Capture – Purify - Enrich™ 
 
It is recommended that prior to the process of purification and enrichment by PhyTip 
columns, all samples be checked for particulates and clarity. If the final solution to be 
purified appears cloudy or contains particulates, it is recommended to spin the samples 
down one more time at 3,000 g for 5 minutes. 
 
Samples can be placed in any position. However the default methods all have samples 
placed in position 3. With the cooling accessory (positions 7 & 8), it is possible to 
maintain both the pre-purified material and the purified sample at sub ambient 
temperatures. 
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2. Preparing wash buffer(s) ready for Purification process 
 
Refer to the Product Insert that is included with each Affinity resin for details on each 
buffer used in the purification process. Some buffers are shipped as concentrates and will 
require dilution before use. 
 
 
3. Prepare Elution Buffer ready for Enrichment process 

 
Refer to the Product Insert that ships with each Affinity resin for details on the Elution 
Buffer used in the enrichment process. If using Protein A or Protein G affinity resins, it is 
recommended to add Neutralization Buffer at the end of the Enrichment step in order to 
return the sample to physiological pH. A separate Neutralization step should be 
incorporated into the automated purification process of the MEA (see standard methods). 
Once the elution buffer has been added to the elution plate, place the PhyTip Cover over 
the plate (see separate instructions) and place in the appropriate position. Place the 
PhyTip Holder over the plate in order to retain the plate in position during the final 
elution process. 
 
4. Load the appropriate Method File 
 
To load the appropriate Method File, go to File on the user screen. Enter Open and the 
choice of Protocol or Method will be shown. Enter Method and hit OK. This will take 
you to folders containing the preprogrammed method files available to run.  Select the 
required file and press Open. The Method will now be available for the system to run. To 
verify the method click on Method – Edit, this displays the robotic steps and all of the 
linked protocols that constitute the given method. To run this method, press Method – 
Execute. 
 
The PC is in constant communication with the MEA. Please do not run other programs 
while running the PhyNexus Operating Software. 
 
5. Store/analyze samples 
 
Once the final enrichment step has been completed, samples will be ready for 
storage/analysis.  
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Standard Methods 
 
Example 1 - IMAC: 
 
Figure 1 below is an example of a standard method (without chiller) of Capture, Purify, 
Enrich using IMAC (Ni-NTA) PhyTip columns for one row of 12 x 200 µL samples. For 
information on configuration of the instrument with and without chiller, see page 29.   
 
Deck configuration for this example is: 
 
Position 1, Row 1:  IMAC 200+ PhyTip columns 
Position 2, Row 1:  Empty 
Position 3, Row 1:  Empty 
Position 4, Row 1:  Recommended volume = 200 µL of Wash 1 
Position 5, Row 1:  Recommended volume = 200 µL of Wash 2 
Position 6, Row 1:  Empty 
Position 7, Row 1:  Recommended volume = 200 µL of Sample 
Position 8, Row 1:  20 µL Elution 
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Figure 1 Standard Method for Capture, Purify & Enrich 
 
 
Command Parameters (if any) 
Home Auto Controller   
Blowout   
Home Controller   
Execute Protocol c:\PN200+Default IMAC Condition 
Position 1,1 
Loadtips   
Position 7,1 
Down 4225 
Execute Protocol c:\PN200+Default IMAC Capture 
Position 4,1 
Down 4280 
Execute Protocol c:\PN200+Default IMAC Wash1 
Position 5,1 
Down 4280 
Execute Protocol c:\PN200+Default IMAC Wash2 
Position 8,1 
Down 4225 
Execute Protocol c:\PN200+Default IMAC Elution 
Position 1,1 
Down 4100 
Eject   
Home Auto Controller   

 
This method shows the automated movement of the 12 channel system for 1 row of 
samples. In detail this can be broken down as follows: 
 

1. Homing the system 
 
Command Parameters (if any)
Home Auto Controller
Blowout
Home Controller
Execute Protocol c:\PN200+Default IMAC Condition
Position/Row 1,1  
Home Auto Controller moves the robotics tower to the Home position – full left 
position. 
Blowout performs a complete blowout of the 12 channel system. 
Home Controller performs a zeroing of the 12 channel system followed by a resetting of 
the system to zero. 
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Execute (c:\PN200+Default IMAC Condition) executes a stored protocol which in this 
case is a conditioning step. The 12 channel system withdraws air into the syringes before 
the PhyTip columns are attached. It does this to create an air buffer in the system that will 
later be used to push liquid out of the PhyTip columns. The volume of air will vary 
depending on the specific set of protocols being used. 
Position 1, Row 1 moves the robotics tower over position number 1 and row 1(the tray of 
PhyTip columns). 
 

2. Moving the PhyTip Columns and Capturing the Sample 
 

Load tips   
Position 7,1 
Down 4225 
Execute Protocol c:\PN200+Default IMAC Capture 

 
 
Load tips moves the 12 channel system down towards the tips in row 1, then positions 
the 12 channel system at an angle to load and then secure all 12 PhyTip columns. 
Position 7, Row 1 automatically moves the robotics tower to the full extent (Position 0) 
and then moves it over to position 7, row 1 (the plate holding the sample to be purified). 
Down moves the robotics head with PhyTip columns down into the sample solution in 
row 1 of position 7. This is a predefined position of 4225 (assumes use of PhyTip Plates 
with known dimensions) in readiness for the Capture step. 
Execute (c:\PN200+Default IMAC Capture) executes the stored protocol that 
implements the Capture process with a given number of cycles, flow rates, volumes and 
pauses, e.g. in the standard method, this will be a volume of 170 µL for 2 cycles at a flow 
rate of 250 µL/min with 10 second pauses at the end of each step. Also note that at the 
end of the capture step, the last cycle expels 172 µL to make sure all of the sample 
solution is removed. 
 

3. Wash and Elution Steps 
Position 4,1 
Down 4280 
Execute Protocol c:\PN200+Default IMAC Wash1 
Position 5,1 
Down 4280 
Execute Protocol c:\PN200+Default IMAC Wash2 
Position 8,1 
Down 4225 
Execute Protocol c:\PN200+Default IMAC Elution 
Position 1,1 
Down 4100 
Eject   
Home Auto Controller   

 
Position 4, Row 1 moves the robotics tower to the full extend position (Position 0), and 
then moves it over to position 4, row 1 ready for the first wash step. 
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Down 4280 moves the robotics tower down to predefined position of 4280 (assumes use 
of PhyTip Plates with known dimensions) ready for the wash step. 
Execute (c:\PN200+Default IMAC Wash 1) implements the stored protocol for the first 
wash step. This protocol, like Capture, will control the flow rate, volume, pause and 
number of cycles involved in this step. 
Position 5, Row 1 moves the robotic tower up to the fully extended zero position and 
then moves it to position 5 and row 1 in readiness for the next wash step.  
Down 4280 moves the robotics tower down to predefined position of 4280 (assumes use 
of PhyTip Plates with known dimensions) ready for the next wash step. 
Execute (c:\PN200+Default IMAC Wash 2) implements the stored protocol for the 
second wash step. This protocol, like Wash 1, will control the flow rate, volume, pause 
and number of cycles involved in this step. 
Position 8, Row 1 moves the robotics tower to the full extend position (Position 0) and 
then moves it over to position 8, row 1, ready for the elution step. 
Down moves the robotics tower down to predefined position of 4225 (assumes use of 
PhyTip Plates with known dimensions) ready for the elution step. 
Execute (c:\PN200+Default IMAC Elution) implements the stored protocol for the 
elution step. This protocol, like Capture, will control the flow rate, volume, pause and 
number of cycles involved in this step. Note at the end of this step, the last expel step is 
greater volume than the other expel steps in order to maximize the total volume of elution 
buffer returned to the elution plate. 
Position 1, Row 1 moves the robotics tower to the full extend position (Position 0) and 
then moves it over to position 1, row 1, ready for the ejection of the PhyTip columns. 
Down 4100 moves the robotics tower down to predefined position of 4100 ready to eject 
the PhyTip columns back into their original position in row 1. 
Eject is a command to remove all of the now used PhyTip columns. 
Home Auto Controller takes the robotics tower back to its safe starting position and 
completes the purification of 1 row of samples. 
 
If using this program as a template, just cut and paste the entire page and replace row 1 
with row 2, etc. 
 
When a method is running, each step of the process will display on the screen. 
Completed steps will display Green, while steps In Progress will display Blue. 
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Example 2 – Protein A: 
 
Figure 2 below is an example of a modified method (without chiller) of Capture, Purify 
& Enrich for Protein A for one row of 12 x 200 µL samples.  For information on 
configuration of the instrument with and without chiller, see page 29.   
 
Deck configuration for this example is as below. 
 
Position 1, Row 1:  Protein A 200+ PhyTip columns 
Position 2, Row 1:  Rainin LTS Tips 
Position 3, Row 1:  Empty 
Position 4, Row 1:  200 µL of Wash 1 
Position 5, Row 1:  200 µL of Wash 2 
Position 6, Reservoir with Neutralization Buffer 
Position 7, Row 1:  200 µL of Sample 
Position 8, Row 1:  20 µL Elution 
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Figure 2  Standard method including addition of Neutralization step  
 
Command Parameters (if any) 
Home Auto Controller   
Blowout   
Home Controller   
Execute Protocol c:\PN200+Default Pro A Condition 
Position 1,1 
Load tips   
Position 7,1 
Down 4225 
Execute Protocol c:\PN200+Default Pro A Capture 
Position 4,1 
Down 4280 
Execute Protocol c:\PN200+Default Pro A Wash1 
Position 5,1 
Down 4280 
Execute Protocol c:\PN200+Default Pro A Wash2 
Position 8,1 
Down 4225 
Execute Protocol c:\PN200+Default Pro A Elution 
Position 1,1 
Down 4100 
Eject   
Eject   
Position 2,1 
Load tips   
Execute Protocol c:\PN200+ Condition 2 
Position 6,1 
Down 4070 
Execute Protocol c:\PN200+ Intake 5uL 
Position 8,1 
Down 4140 
Execute Protocol c:\PN200+ Expel 5uL 
Position 2,1 
Down 4100 
Eject   
Home Auto Controller   

 
 
This method shows the automated movement of the 12 channel system for 1 row of 
samples. In detail, this can be broken down as follows: 
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1. Homing the system 
 
Command Parameters (if any)
Home Auto Controller
Blowout
Home Controller
Execute Protocol c:\PN200+Default Pro A Condition
Position/Row 1,1  
Home Auto Controller moves the robotics tower to the Home position – full left 
position. 
Blowout performs a complete blowout of the 12 channel system. 
Home Controller performs a zeroing of the 12 channel system followed by a resetting of 
the system to zero. 
Execute (c:\PN200+Default ProA Condition) executes a stored protocol which in this 
case is a conditioning step. The 12 channel system withdraws air into the syringes before 
the PhyTip columns are attached. It does this to create an air buffer in the system that will 
later be used to push liquid out of the PhyTip columns. The volume of air will vary 
depending on the specific set of protocols being used. 
Position 1, Row 1 moves the robotics tower over position number 1 and row 1(The tray 
of PhyTip columns). 
 

2. Moving the PhyTip Columns and Capturing the Sample 
 

Load tips   
Position 7,1 
Down 4225 
Execute Protocol c:\PN200+Default Pro A Capture 

 
 
Load tips moves the 12 channel system down towards the tips in row 1 then moves the 
12 channel system at an angle to load and secure all 12 PhyTip columns. 
Position 7, Row 1 automatically moves the robotics tower to the full extent (Position 0) 
and then moves it over to position 7, row 1 (the plate holding the sample to be purified). 
Down moves the robotics head with PhyTip columns down into the sample solution in 
row 1 of position 7. This is a predefined position of 4225 (assumes use of PhyTip Plates 
with known dimensions) in readiness for the Capture step. 
Execute (c:\PN200+Default ProA Capture) executes the stored protocol that implements 
the Capture process with a given number of cycles, flow rates, volumes and pauses e.g. in 
the standard method this will be a volume of 170 µL for 2 cycles at a flow rate of 250 
µL/min with 10 second pauses at the end of each step. Also note that at the end of the 
capture step, the last cycle expels 172 µL to make sure all of the sample solution is 
removed. 
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3. Wash and Elution Steps 

 
Position 4,1 
Down 4280 
Execute Protocol c:\PN200+Default Pro A Wash1 
Position 5,1 
Down 4280 
Execute Protocol c:\PN200+Default Pro A Wash2 
Position 8,1 
Down 4225 
Execute Protocol c:\PN200+Default Pro A Elution 
Position 1,1 
Down 4100 
Eject   
Eject   

 
Position 4, Row 1 moves the robotics tower to the full extend position (Position 0) and 
then moves it over to position 4, row 1 ready for the first wash step. 
Down 4280 moves the robotics tower down to predefined position of 4280 (assumes use 
of PhyTip Plates with known dimensions) ready for the wash step. 
Execute (c:\PN200+Default Pro A Wash 1) implements the stored protocol for the first 
wash step. This protocol, like Capture, will control the flow rate, volume, pause and 
number of cycles involved in this step. 
Position 5, Row 1 moves the robotic tower up to the fully extended zero position and 
then moves it to position 5 and row 1 in readiness for the next wash step.  
Down 4280 moves the robotics tower down to predefined position of 4280 (assumes use 
of PhyTip Plates with known dimensions) ready for the next wash step. 
Execute (c:\PN200+Default Pro A Wash 2) implements the stored protocol for the 
second wash step. This protocol, like Wash 1, will control the flow rate, volume, pause 
and number of cycles involved in this step. 
Position 8, Row 1 moves the robotics tower to the full extend position (Position 0) and 
then moves it over to position 8, row 1 ready for the elution step. 
Down moves the robotics tower down to predefined position of 4225 (assumes use of 
PhyTip Plates with known dimensions) ready for the elution step. 
Execute (c:\PN200+Default Pro A Elution) implements the stored protocol for the 
elution step. This protocol, like Capture, will control the flow rate, volume, pause and 
number of cycles involved in this step. Note at the end of this step, the last expel step is 
greater volume than the other expel steps in order to maximize the total volume of elution 
buffer returned to the elution plate. 
Position 1, Row 1 moves the robotics tower to the full extend position (Position 0) and 
then moves it over to position 1, row 1 ready for the ejection of the PhyTip columns. 
Down 4100 moves the robotics tower down to predefined position of 4100, ready to eject 
the PhyTip columns back into their original position in row 1. 
Eject is a command to remove all of the now used PhyTip columns. 
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4. Neutralization 
 
Position 2,1 
Load tips   
Execute Protocol c:\PN200+ Condition 2 
Position 6,1 
Down 4070 
Execute Protocol c:\PN200+ Intake 5uL 
Position 8,1 
Down 4140 
Execute Protocol c:\PN200+ Expel 5uL 
Position 2,1 
Down 4100 
Eject   
Home Auto Controller   

 
Position 2, Row 1 moves the robotics tower over position number 2 and row 1 (The tray 
of Rainin LTS Tips). 
Load tips moves the 12 channel head down to the pre assigned position to automatically 
load the tips onto the 12 channel system. 
Execute (c:\PN200+ Condition 2) executes a stored protocol which in this case is a 
conditioning step. The 12 channel system withdraws air into the syringes before the LTS 
tips are attached. It does this to create an air buffer in the system that will later be used to 
push liquid out of the LTS tips. The volume of air will vary depending on the specific set 
of protocols being used. 
Position 6, Row 1 automatically moves the robotics tower to the full extent (Position 0) 
and then moves it over to position 6, (the Neutralization Buffer Reservoir). 
Down 4070 moves the robotics head with Tips down into the neutralization buffer. This 
is a predefined position of 4070 in readiness for removing the Neutralization buffer. 
Execute (c:\PN200+Intake 5 µL) executes the stored protocol that implements the 
removal of 5 µL of neutralization buffer into the 12 Tips. 
Position 8, Row 1 automatically moves the robotics tower to the full extent (Position 0) 
and then moves it over to position 8, row 1(the row that contains the purified protein). 
Down 4140 moves the robotics head with Tips with neutralization buffer down to the 
predefined position of 4140 in readiness for adding the Neutralization buffer. 
Execute (c:\PN200+Expel 5 µL) executes the stored protocol that implements the 
expelling of 5 µL of neutralization buffer into row 1. 
Position 2, Row 1 automatically moves the robotics tower to the full extent (Position 0) 
and then moves it over to position 2, row 1 (the original tray for the Rainin Tips). 
Down 4100 moves the robotics head with Tips down to a predefined position of 4100 in 
readiness for removing the Tips from the 12 channel system. 
Eject removes the tips into their original position. 
Home Auto Controller takes the robotics tower back to its safe starting position and 
completes the purification of 1 row of samples. 
 
If using this program as a template, just cut and paste the entire page and replace row 1 
with row 2, etc. 
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Example 3 
 
Optimization Method. 
 
The MEA can be used as a very rapid optimization platform to assess the optimum 
conditions for purifying protein samples. Below is an experimental design format as an 
example, with Ni-NTA resin: 
 
Capture 
 
Prepare the standard 96-well sample plate and program the MEA as follows: 
For the Capture protocol have Rows A, C, E & G have 2 Capture cycles, and Rows B, D, 
F & H have 4 Capture cycles. 
 
 Column           
Row 1 2 3 4 5 6 7 8 9 10 11 12 

A 2 2 2 2 2 2 2 2 2 2 2 2 
B 4 4 4 4 4 4 4 4 4 4 4 4 
C 2 2 2 2 2 2 2 2 2 2 2 2 
D 4 4 4 4 4 4 4 4 4 4 4 4 
E 2 2 2 2 2 2 2 2 2 2 2 2 
F 4 4 4 4 4 4 4 4 4 4 4 4 
G 2 2 2 2 2 2 2 2 2 2 2 2 
H 4 4 4 4 4 4 4 4 4 4 4 4 

 
 
 
Purify 
 
The wash process for purification can be optimized when using Ni-NTA resin by varying 
the concentration of the Imidazole in the wash buffer.  
 
In this example, rows A&B have 0 mM Imidazole in the wash buffer, rows C&D have 5 
mM, E&F have 10 mM, and G&H have 20 mM Imidazole.  
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 Column           

Row 1 2 3 4 5 6 7 8 9 10 11 12
A 0 0 0 0 0 0 0 0 0 0 0 0 

B 0 0 0 0 0 0 0 0 0 0 0 0 

C 5 5 5 5 5 5 5 5 5 5 5 5 

D 5 5 5 5 5 5 5 5 5 5 5 5 

E 10 10 10 10 10 10 10 10 10 10 10 10

F 10 10 10 10 10 10 10 10 10 10 10 10

G 20 20 20 20 20 20 20 20 20 20 20 20

H 20 20 20 20 20 20 20 20 20 20 20 20
 
 
 
 
Purification Step 2 
 
This can be a repeat of Wash 1, using the exact same methodology. 
 
Enrich 
 
The final elution step can now be compared using two concentrations of Imidazole to 
remove the his-tagged protein, e.g. columns 1-6 are eluted with a 150 mM Imidazole 
buffer and columns 7-12 are eluted with a 250 mM Imidazole buffer. 
 

Column
Row 1 2 3 4 5 6 7 8 9 10 11 12

A 150 150 150 150 150 150 250 250 250 250 250 250
B 150 150 150 150 150 150 250 250 250 250 250 250
C 150 150 150 150 150 150 250 250 250 250 250 250
D 150 150 150 150 150 150 250 250 250 250 250 250
E 150 150 150 150 150 150 250 250 250 250 250 250
F 150 150 150 150 150 150 250 250 250 250 250 250
G 150 150 150 150 150 150 250 250 250 250 250 250
H 150 150 150 150 150 150 250 250 250 250 250 250  

 
 
 
This one experiment, which can be run in less than 2 hours, allows for a statistically 
significant number of comparisons of capture conditions, wash conditions and elution 
conditions. 
 



 

Version 1.7.8  Nov 8, 2005 
Copyright © 2005, PhyNexus, Inc., All Rights Reserved. 
 

33

Standard Methods: 
 
The following standard methods have been built into the standard operating software: 
 
For 200+ PhyTip columns and 200 + 12 channel system 
 
Without the Cooling Accessory: Position 7 is for the sample and position 8 is for elution. 
 
1. Protein A with included neutralization step 
2. Protein G with included neutralization step 
3. IMAC    
4. Glutathione 
 
With the Cooling Accessory: Position 7 is for the sample and position 8 is for elution. 
 
1. Protein A with included neutralization step 
2. Protein G with included neutralization step 
3. IMAC    
4. Glutathione 
 
For 1000+ PhyTip columns and 1000 + 12 channel system 
 
Without the Cooling Accessory: Position 7 is for the sample and position 8 is for elution. 
 
1. Protein A with included neutralization step 
2. Protein G with included neutralization step 
3. IMAC      
4. Glutathione 
 
With the Cooling Accessory: Position 7 is for the sample and position 8 is for elution. 
 
1. Protein A with included neutralization step 
2. Protein G with included neutralization step 
3. IMAC      
4. Glutathione 
 
 
 
 
 



 

Version 1.7.8  Nov 8, 2005 
Copyright © 2005, PhyNexus, Inc., All Rights Reserved. 
 

34

Full x-axis and z-axis positions. 
For the 200+ 12 channel system: 
 

x-axis # x-axis #
Position 1 Row 1 0 Position 2 Row 1 5648
PhyTip columns Row 2 567 PhyTip columns Row 2 6215

Row 3 1134 Row 3 6782
Row 4 1701 Row 4 7349
Row 5 2268 Row 5 7916
Row 6 2834 Row 6 8482
Row 7 3401 Row 7 9049
Row 8 3968 Row 8 9616

PhyTip columns z-axis: Rainin LTS Tips z-axis:
Load = 4270. Eject = 4100 Load=4270. Eject = 4100

x-axis # x-axis #
Position 3 Row 1 11240 Position 4 Row 1 16723
Sample Plate Row 2 11807 Wash 1 Row 2 17290
(PhyTip Plate) Row 3 12374 (PhyTip Plate) Row 3 17857

Row 4 12941 Row 4 18424
Row 5 13508 Row 5 18991
Row 6 14074 Row 6 19558
Row 7 14641 Row 7 20124
Row 8 15208 Row 8 20691

PhyTip columns z-axis: PhyTip columns z-axis:
Sample Plate= 4280 Wash Plate= 4280

x-axis # Position 6 x-axis #
Position 5 Row 1 22206 Neutralization
Wash 2 Row 2 22773 Reservoir 27674
(PhyTip Plate) Row 3 23340 Rainin LTS Tips z-axis:

Row 4 23907 Neutralization= 4070
Row 5 24474
Row 6 25041
Row 7 25608
Row 8 26175

PhyTip columns z-axis:
Wash Plate= 4280

x-axis # x-axis #
Position 7 Row 1 29152 Position 8 Row 1 34640
Elution Row 2 29719  Row 2 35207
(PhyTip Plate) Row 3 30286 Row 3 35774

Row 4 30853 Row 4 36341
Row 5 31420 Row 5 36908
Row 6 31986 Row 6 37474
Row 7 32553 Row 7 38041
Row 8 33120 Row 8 38608

With Cooling System z-axis With Cooling System z-axis
PhyTip Elution = 4225 PhyTip Elution = 4225
Rainin LTS = 4140 Rainin LTS = 4140

Without Cooling System z-axis Without Cooling System z-axis
PhyTip Elution = 4280 PhyTip Elution = 4280
Rainin LTS = 4195 Rainin LTS = 4195  
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For the 1000+ 12 channel system: 
 

x-axis # x-axis #
Position 1 Row 1 0 Position 2 Row 1 5648
PhyTip columns Row 2 567 PhyTip columns Row 2 6215

Row 3 1134 Row 3 6782
Row 4 1701 Row 4 7349
Row 5 2268 Row 5 7916
Row 6 2834 Row 6 8482
Row 7 3401 Row 7 9049
Row 8 3968 Row 8 9616

PhyTip columns z-axis: Rainin LTS Tips z-axis:
Load = 3600. Eject = 3500 Load=3600. Eject = 3500

x-axis # x-axis #
Position 3 Row 1 11240 Position 4 Row 1 16723
Sample Plate Row 2 11807 Wash 1 Row 2 17290
(PhyTip Deep Well) Row 3 12374 (PhyTip Deep Well) Row 3 17857

Row 4 12941 Row 4 18424
Row 5 13508 Row 5 18991
Row 6 14074 Row 6 19558
Row 7 14641 Row 7 20124
Row 8 15208 Row 8 20691

PhyTip columns z-axis: PhyTip columns z-axis:
Sample Plate= 2310 Wash Plate= 2310

x-axis # Position 6 x-axis #
Position 5 Row 1 22206 Neutralization
Wash 2 Row 2 22773 Reservoir 27674
(PhyTip Deep Well) Row 3 23340 Rainin LTS Tips z-axis:

Row 4 23907 Neutralization= 2050
Row 5 24474
Row 6 25041
Row 7 25608
Row 8 26175

PhyTip columns z-axis:
Wash Plate= 2310

x-axis # x-axis #
Position 7 Row 1 29152 Position 8 Row 1 34640
Elution Row 2 29719  Row 2 35207
(PhyTip Plate) Row 3 30286 Row 3 35774

Row 4 30853 Row 4 36341
Row 5 31420 Row 5 36908
Row 6 31986 Row 6 37474
Row 7 32553 Row 7 38041
Row 8 33120 Row 8 38608

With Cooling System z-axis With Cooling System z-axis
PhyTip Elution = 2310 PhyTip Elution = 2310
Rainin LTS = 2120 Rainin LTS = 2120

Without Cooling System z-axis Without Cooling System z-axis
PhyTip Elution = 2365 PhyTip Elution = 2365
Rainin LTS = 2175 Rainin LTS = 2175  
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Protocols 
 
Protocols define the flow rates, volume and pauses associated with the process of 
Capture-Purify-Enrich. There are a series of standard protocols that have been stored in 
the software, e.g.: 
 
200+ ProA Condition 
200+ ProA Capture 
200+ ProA Wash 1 
200+ ProA Wash 2 
200+ ProA Elute 
200+ ProA Condition 2 
200+ ProA Intake 5 µL 
200+ ProA Expel 5 µL 
(These protocols represent a series of steps that would be used for the 200+ PhyTip 
columns containing Protein A affinity resin; there are others for 200+ Protein G, IMAC 
and Glutathione plus 1000+ Protein A, Protein G, IMAC and Glutathione). 
 
The standard methods have been written to incorporate a series of the standard protocols 
so that the process of Capture-Purify-Enrich can simply be carried out without the need 
for further programming. 
 
200 + Protocol 
 
As an example of these protocols when using the standard 200+ Protein A Method, there 
are several “Execute” steps that reference the following steps: 
 
200+ Pro A Condition
Volume (mL) Rate (mL/min) Times to do Delay (sec)

0.01 1 1 0  
 
Condition: This conditions the 12 channel system to prepare for the complete process of 
moving liquids over the resin bed in the PhyTip columns. The final process of elution 
will often require only 10 µL of elution buffer to be moved over the resin bed and then 
expelled. In order to be sure that all of this liquid can be blown out, a sufficient reservoir 
of air must be added to the 12 channel system before the PhyTip columns are attached. 
In this case 10 µL of air is moved into the 12 channel system at a rate of 1 mL/minute. 
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200+ Pro A Capture   
Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.17 0.25 1 10
-0.17 0.25 1 10
0.17 0.25 1 10

-0.17 0.25 1 10
0.17 0.25 1 10

-0.17 0.25 1 10
0.17 0.25 1 10

-0.172 0.25 1 10
Capture: Passes the sample over the resin bed enabling the Protein A affinity resin to 
bind the protein of interest. In this case 170 µL of sample is moved into the PhyTip 
(Intake) and 170 µL is moved out (Expelled). Intake can be seen as the positive number 
and expel the negative number, also note that all expel steps are colored red. Note that 
there are two expel steps. Therefore, two cycles of Capture and that at the end of the 
second cycle 172 µL is expelled from the PhyTip column. This extra volume is part of the 
original 10 µL Condition step and helps to remove as much sample solution as possible 
prior to the Wash steps. 
 
The Flow Rate is 250 µL/min (expressed as 0.25 mL/min) with a delay of 10 seconds at 
the end of each step. This delay step of 10 seconds is built into the system to allow for the 
full equilibration of all PhyTip columns in all positions.  
 
To modify any of the parameters, click on the parameter line and an “Edit Protocol Step” 
screen will display. This has several boxes that can be modified (see Section B, Detailed 
software Information): Volume (sets the desired volume), Volume Units: (references the 
volume, with mL or µL available), Direction (Expel or Intake), Volume Prior to this Step 
(indicates last volume input), How Many Times (number of times to repeat sequentially 
this specific step), Rate (the flow rate), Rate units (shows mL/hr, mL/min, µL/hr, µL/min) 
and Delay (in seconds). 
 
200+ Pro A Wash 1
Volume (mL) Rate (mL/min) Times to do Delay (sec)

0.17 0.5 1 10
-0.17 0.5 1 10
0.17 0.5 1 10

-0.17 0.5 1 10  
 
Wash 1: This is the first of two washing (Purification) steps, here two cycles of moving 
170 µL of Wash Buffer 1 is accomplished at a flow rate of 500 µL/min (expressed as 0.5 
mL/min) with a delay of 10 seconds at the end of each step. Note that on the final expel 
step, the volume is the same as all the intake steps. At this first step, there is no need to 
expel any further volume since the next step is another wash step. 
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200+ Pro A Wash 2
Volume (mL) Rate (mL/min) Times to do Delay (sec)

0.18 0.5 1 10
-0.18 0.5 1 10
0.18 0.5 1 10

-0.182 0.5 1 10  
 
Wash 2: This is the second wash step, again two cycles at the same flow rate as Wash 
Step 1. Now however, there is a larger volume of wash buffer (180 µL) and at the final 
expel step there is an extra 2 µL of volume expelled from the PhyTip column (-182 µL). 
 
200+ Pro A Elute
Volume (mL) Rate (mL/min) Times to do Delay (sec)

0.05 0.5 1 10
-0.05 0.5 1 10
0.05 0.5 1 10

-0.05 0.5 1 10
0.05 0.5 1 10

-0.05 0.5 1 10
0.05 0.5 1 10

-0.05 0.5 1 10
0.05 0.5 1 10

-0.056 0.5 1 10  
 
Elute: The final step in the purification process uses 5 cycles of rapid flow elution over 
the resin bed. In this case, although only 10 µL is being used as the Elution volume, the 
protocol is stored as 50 µL. This difference between actual physical volume and 
programmed volume allows for all of the Elution buffer to pass over the resin bed, thus 
maximizing the total yield of purified protein that can be obtained from the column. It is 
essential to “overdrive” this step (50µL to pick up 10µL of liquid) to overcome the 
surface tensions and pressures that are caused by the initial insertion of the tip, and bed 
resistance in the tip. The required balance is to pull up enough to get the fluid to move, 
but not too much such that the volume of fluid pulls an air bubble. 
 
As a programming guideline, if a higher volume for elution is needed, add 40 to the final 
volume number to obtain the programmed elution volume, e.g. if 30 µL is the final 
elution volume required, program 30 + 40 = 70 µL for the final elution volume. This 
guideline is valid for elution volumes less than 75 µl.  For elution volumes greater or 
equal to 75 µl, simply program that same volume.  
 
Again note that the final step expels 56 µL to maximize the volume of Elution Buffer 
returned (Note: Initial Conditioning step has Intake volume of 10 µL. Capture has excess 
expel of 2 µL; Wash 2 has excess expel of 2 µL; and the final Elution step has an excess 
expel of 6 µL, thus balancing the Intake and Expel for the entire process). 
 
200+ ProA Condition 2   
Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.02 1 1 0 
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Conditioning 2: this step conditions the 12 channel system prior to adding the Rainin 
LTS Tips for the Neutralization Step. Air (20 µL) is taken in at a flow rate of 1 mL/min. 
 
200+ ProA Intake 5 uL   
Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.005 6 1 2 
 
Intake 5 µL: This step pulls 5 µL of neutralization buffer into the Rainin LTS Tips at a 
flow rate of 6 mL/min. 
 
200+ ProA Expel 5 uL   
Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.025 2 1 2 

 
Expel 5 µL: This step expels the 5 µL of Neutralization Buffer from the Rainin LTS Tips 
into the specified row at a flow rate of 2 mL/min. The step requires 25 uL of expel, the 
first 20 uL is air and the remaining 5 is the neutralization buffer. Note the negative 
number indicating an expel step. 
 
1000+ Protocol 
 
Below is an example of the protocols for a 1000+ PhyTip column system using IMAC as 
the affinity resin: 
 
1000+ IMAC Condition
Volume (mL) Rate (mL/min) TImes to do Delay (sec)

0.09 3 1 0  
 
1000+ IMAC Capture   
Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.45 0.25 1 20
-0.45 0.25 1 20
0.45 0.25 1 20

-0.45 0.25 1 20
0.45 0.25 1 20

-0.45 0.25 1 20
0.45 0.25 1 20

-0.47 0.25 1 20
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1000+ IMAC Wash 1
Volume (mL) Rate (mL/min) TImes to do Delay (sec)

0.9 0.5 1 20
-0.9 0.5 1 20
0.9 0.5 1 20

-0.9 0.5 1 20  
 
1000+ IMAC Wash 2
Volume (mL) Rate (mL/min) TImes to do Delay (sec)

0.5 0.5 1 20
-0.5 0.5 1 20
0.5 0.5 1 20

-0.52 0.5 1 20  
 
1000+ IMAC Elute
Volume (mL) Rate (mL/min) TImes to do Delay (sec)

0.25 0.5 1 20
-0.25 0.5 1 20
0.25 0.5 1 20

-0.25 0.5 1 20
0.25 0.5 1 20

-0.25 0.5 1 20
0.25 0.5 1 20

-0.25 0.5 1 20
0.25 0.5 1 20
-0.3 0.5 1 20  

 
Note: The initial conditioning step of 90 µL and the subsequent combination of excess 
expels total 90 µL. Also the final elution volume of 20 µL requires an intake/expel of 250 
µL.    
 
As a programming guideline, if a higher volume for elution is needed, add 230 to the 
final volume number to obtain the programmed elution volume, e.g. if 30 µL is the final 
elution volume required, program 30 + 230 = 260 µL for the final elution volume. This 
guideline is valid for elution volumes less than 250 µl.  For elution volumes greater 
or equal to 250 µl, simply program that same volume.  
 
Manual methods programming 
 
The MEA software not only includes standard Methods and Protocols that can be simply 
modified, but also a feature that allows the user to calculate and program specific 
positions on the deck. The standard windows screen shows five basic headings: 
 
                            File – Protocol – Method – Options – Help.  
 
File is the standard New/Open/Save/Save as found in most Windows applications. 
Protocol contains Execute/Edit. Execute begins the loaded Protocol and Edit allows the 
user to Edit the loaded Protocol. 
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Method contains Execute/Verify/Edit. Execute begins the loaded Method, Verify checks 
that the Method can be operated and Edit allows the user to Edit the loaded Method. 
Options contain Communications/Syringe. Communications sets the COM port for the 
system and Syringe verifies the 12 channel system type (200+ or 1000+). 
Help shows the About information regarding the system. 
 
To access the ability to specify x-z positioning of the 12 channel system press Shift – Alt, 
this will add two new functions to the Options field: 
 
Simulation Mode: allows the user to run a method on the software only, disconnecting the 
functions of the MEA. This can be used to verify/check that all of the software 
programming is compatible without running the MEA. 
 
Terminal: allows the user to move the 12 channel system, via a series of typed commands 
to any position on the deck. This function allows the user to verify specific positions on 
the MEA and to design new methods that are different to the stored methods. 
Specific position commands can be entered in the window and once the “send” command 
is hit, the robotics tower with 12 channel system will move to that specific position. 
Commands are entered in the window to the right of the “send” command button. Once 
the command has been entered, press ‘send.’ This will initiate the command and in the 
screen box above this window there will be a confirmation that the command has been 
implemented  e.g. Response OK. 
 
Commands 
 
Home: moves the robotics tower and 12 channel system back to starting home position 
(x= 0 and z=0) 
 
Down #:  (where # = any number between 0 and 4275) moves the 12 channel system 
down to a specific point. It is recommended to place two Tips that will be used in the 
process on positions 1 and 12 of the 12 channel system in order to position the base of the 
tip correctly. Note that when the 12 channel system is in the full up position (0), then to 
move the system down, just type in the desired position number e.g. 2500. However, if 
the 12 channel system is not at the zero position e.g. 2500 and you want to move the 
system down a further 100 stepper motor points, type in Down 100 and this moves the 
system to position 2600. 
 
Up: moves the 12 channel system back to zero position, fully up. 
 
X pos - #: (where # = any number between 0 and 39,100) moves the robotics tower and 
12 channel system to a specific point on the x- axis along the deck. It is recommended to 
place two Tips that will be used in the process on positions 1 and 12 of the 12 channel 
system in order to position the tip correctly. 
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Section B 
 
1. Introduction 
 
PhyNexus auto controller software is a graphical user interface application which is 
intended to allow the user to perform the following tasks: 
 

1. Open, verify, and execute files which perform intake and expel operations. 
2. Edit and save protocol files. 
3. Open, verify, and execute method files which execute protocol files and other 

commands, such as instructions to the auto controller. 
4. Edit and save method files. 
5. Perform manual intake, expel, and blowout / home operations. 

 
The auto controller software is intended for use on 32-bit Microsoft Windows platforms 
(Windows ’95, ’98, Me, NT, 2000, and XP) and communicates with the Rainin 
automated pipettor / controller via the Auto Controller. 
 

1.1 Conventions 
 
The auto controller software will afterwards be referred to as the app.   
 
Menu and submenu options will be referred to using the -> notation.  For example, the 
Open option under the File menu is referred to as File->Open. 
 

1.2 Definitions 
 
A protocol is a series of steps which command the controller to intake or expel liquid.  
Each step of a protocol specifies a volume (positive to intake, negative to expel), a rate, 
and a number of times to repeat.  An optional post-step delay may also be specified. 
 
A method is a series of steps which group protocol(s) together and also provide some 
user-interface functionality.  The following actions can be steps of a method: 
 

1. Execute (specified by filename). 
2. Audible alert (beep). 
3. Pause (display message, and wait for user input to either continue method or 
    abort). 
4. Blow out contents. 
5. Reset to home position. 
6. Comment (solely for documentation of the method file – not seen by the  
    operator). 
7. Auto controller instructions: 
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 a. Reset all axes to home position. 
 b. Position above tray at specified step. 
 c. Move controller down towards tray by specified number of steps. 
 d. Load tips onto controller. 
 e. Move controller to retracted position (performed automatically by tray 
                command [b]). 
 f. Remove tips from controller. 
 g. Turn external controller on / off. 

 

1.3 Compatibility  
 
The auto controller (MEA system) is assumed to be connected in between the host 
computer and the controller (the 12 channel system). No other system or options are 
compatible with the MEA system. 
 

2. How to open and execute a protocol 
 
The following window appears when the app first runs: 
 

 
 
The status bar (lower portion of the screen) shows the app status at any time.  Initially 
the app is not communicating with the controller, so the status bar shows the message 
“Offline” when it starts. 
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2.1 Open protocol file 
 
Use the File->Open menu option and select Protocol to browse for a protocol file, as 
shown below: 
 

 
 
Protocol files are assumed to have a .psc file extension.  If the protocol file was opened 
successfully, then it may be verified, executed and/or edited.   
 
If the app displays an error message when you try to open the protocol file, then it may 
have been corrupted, e.g. via disk error or hand-editing, or the file selected is simply not a 
protocol. 
 
The last four successfully-opened files are added to an MRU (most-recently-used) list in 
the file menu, as shown below: 
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When the filename is selected from the MRU, the app attempts to open the file.  If the 
file cannot be opened or no longer exists, then it is removed from the MRU. 
 

2.2 Execute  
 
Before executing the protocol, make sure of the following: 
 

1. All PhyTip columns, sample plates, wash buffers, etc., are in place. 
 
2. App’s serial parameters are set to match those of the controller. 

 
3. The capacity of the PhyTip columns matches the volume required to be 

processed. 
 
After these items have been checked, the protocol can be executed. 
 

2.2.1 Check serial port 
 
The app’s serial port setting may be adjusted by selecting the Options->Serial menu, 
which pops up a dialog as follows: 
 

 
 
Make sure that the port setting corresponds to the one on the PC that is connected to the 
auto controller.  Initially, the app uses port 1, but remembers the last setting used (See 
registry settings below). 
 
Note:  
 

• Settings for the comm port can only be changed when the app is not 
communicating with the auto controller (not executing a protocol, method or 
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manual override command).  Pressing ‘Stop’ terminates communication, and 
allows these settings to be changed (see below). 

 

2.2.2 Check capacity setting 
 
The capacity setting may be adjusted via the Options->Syringe menu, which pops up the 
following dialog: 
 

 
 
The setting shown above is for the 200 µL capacity.  The app is initially set up for 200 
µL, but remembers the last settings used (See Registry Settings below). 
 
Also note that the current capacity is displayed on the main window of the app. 
 
The capacity setting can only be changed when the app is not communicating with the 
auto controller (not executing a protocol, method or manual override command).  
Pressing ‘Stop’ also stops communication so that these settings can be changed. 
 

2.2.2.1 Capacity and verification 
 
If the capacity setting is changed while a protocol is open, the user is prompted as 
follows: 
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This message indicates that the protocol may not execute properly with the new capacity 
setting.   
 
 

2.2.2.2 Capacity and protocols 
 
If a protocol specifies a different capacity than the current app settings, the user is 
prompted as follows when the protocol file is opened: 
 

 
 
Answer “yes” to set the app’s capacity setting to match the protocol, or “no” to do so 
later.   
 
Note: Answering “no” may prevent the protocol from executing properly. 
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2.2.3 Start protocol execution 
 
Once the protocol has been opened, and the controller has been prepared for protocol 
execution, select the Protocol->Execute option.  The app will establish communication 
with the controller (go online), get the controller’s software version and capacity, disable 
the controller’s keyboard / speaker / LCD display, and get the current volume.  The 
protocol will then be automatically verified, as noted in section 2.3 below, using the 
controller’s current volume.  Then the app will instruct the controller to execute the 
intake or expel steps contained in the protocol. 
 
The app displays the following during protocol execution: 
 

1. Status bar displays the protocol step and step type (intake/expel). 
 
2. Progress bar (to the right of the status bar text) shows progress in total execution 

time, as calculated by the volume and rate of each step. 
 
3. Volume displays the current volume in the syringe, as reported by the controller 

after the most-recently-executed step. 
 

4. Controller shows the firmware version of the controller.   
 
5. Auto Controller shows the firmware version of the auto controller. 

 
An example is as follows: 
 

 
 
When the protocol is completed, the status bar will display “Protocol execution 
complete” and the Volume indicator will show how much volume is in the syringe at the 
end of the protocol. 
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The protocol is automatically terminated if an error occurs during execution, and the error 
is shown in the status bar.  See “Possible errors and corrective action” below (section 
2.2.3.2). 
 

2.2.3.1 Stopping protocol execution 
 
If the protocol needs to be stopped before it’s complete, then press the Stop button.  
Pressing stop terminates the app’s execution of the protocol, but the controller will 
continue executing the last command issued by the controller until it has been completed. 
 
 

2.2.3.2 Possible errors and corrective action 
 
If a Port in use error results when the protocol is executed, then some other application is 
using the serial port selected (See section 2.2.1 above). Possibly a modem is plugged in 
and is being used, or the HyperTerminal app (which is found on most versions of 
Windows).  To fix this, select a different serial port from the Serial Options dialog and try 
again, or find the application which is using the serial port, and shut it down. 
 
The error No response from controller (offline) indicates that the serial port selected is 
not actually connected to the controller.  Select a different serial port and try again.  
Similarly, No response from auto controller (offline) indicates that the serial port 
selected is not actually connected to the auto controller. 
  
Controller error (command not echoed, bad checksum, invalid parameter or command) 
indicates a problem communicating with the controller over the serial cable, or an 
incompatible version of controller firmware.  Check that the serial cable is in good 
condition, and that the controller firmware version is supported by the app (see section 1 
above). 
 
 

2.3 Verify protocol 
 
Verification is performed automatically by the app prior to executing a protocol, but may 
also be invoked manually.  In this process, the app checks that the following rules are 
followed during the protocol: 
 

1. Volume never falls below zero.   
2. Volume never rises above the capacity (see also section 2.2.2.1). 
3. Flow rates are within limits for the capacity (see Appendix D). 

 
When verification is performed automatically just prior to protocol execution, the initial 
volume is assumed to be that reported by the controller. 
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A protocol may be manually verified using the Protocol->Verify menu option.  In this 
case, whatever current volume is presently reported by the controller is assumed to be the 
initial volume for verification purposes.  If the app has not yet gone online, then the 
initial volume is assumed to be zero. 
 
If protocol verification fails, then an error message appears showing the line in the 
protocol at which the error occurred.  
 
 

3. How to open and execute a method 
 
Handling of methods is similar to that of protocols.   
 

3.1 Open Method 
 
Use the File->Open menu option and select Method to browse for a method file, as 
shown below : 
 

 
 
Method files are assumed to have a .pba file extension.  If the method file was opened 
successfully, then it may be executed and/or edited.   
 
If the app displays an error message when you try to open the method file, then it may 
have been corrupted, e.g. via disk error or hand-editing, or the file selected is simply not a 
method. 
 
The MRU (most-recently-used) list in the file menu also handles method files. 
 
After opening the method file, the display will indicate the currently-open method, as 
shown below: 
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3.2 Execute method 
 
Before executing the method, make sure of the following: (see section 2.2 above) 
 

1. 12 channel system is correctly mounted on the controller. 
 
2. App’s serial parameters are set to match those of auto controller. 

 
3. App’s capacity setting matches the syringe capacity. 

 
To execute the currently-open method, select the Method->Execute menu option.  The 
app will then go online with the controller, much as it would while executing a protocol. 
 
When a Pause method command is executed, the app displays the message specified in 
the command, and stops to wait for operator intervention, as shown below: 
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The operator can press OK to proceed with method execution, or Cancel to abort the 
method. 
The appearance of the app while executing a protocol within a method is very similar to 
that when simply executing a protocol standalone – the only difference is that the method 
name is shown instead of the protocol name, as shown here: 
 

 
 
Similarly, the Blowout and Home commands cause the status bar to be updated, and 
Volume to be zeroed. 
 
See section 2.2.3 above for information on stopping execution, and possible errors that 
may occur, since this information applies equally to methods as well as protocols. 
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4. Manual Commands 
 
The controller can be instructed to perform individual intake and expel steps when the 
app isn’t running a protocol.  The following procedure should be used: 
 

1. Verify that the 12 channel system is mounted in the controller correctly, as above. 
 
2. Verify that the app’s serial parameters match those of the controller, as above. 

 
3. Verify that the app’s capacity setting matches that of the syringe, as above. 

 
4. Enter the volume and rate in the text boxes under the Manual Overrides frame, 

and then press the Intake or Expel button.   
 
This will cause the app to go online with the controller and execute the intake or expel 
step.  Status will be shown in the status bar, and the Volume indicator will be updated 
when the operation is completed, if successful. 
 
See section 2.2.3.2 above for troubleshooting. 
 

4.1 Reset volume 
 
The Reset button may be used to manually blow out the syringe contents, and reset its 
volume to the “home” position (zero). 
 

4.2 Stopping manual commands 
 
Manual intake/expel operations may be aborted using the Stop button.  As with aborting 
protocol or method execution, pressing stop will only prevent the app from issuing 
further commands to the controller, but the controller will finish executing the last 
command it was given.  When this last command is complete, the app will display the 
current volume as last reported by the controller. 
 
Note: Communications and Syringe settings can only be changed when the app is not 
communicating with the controller (not executing a protocol, method or manual override 
command).  Pressing ‘Stop’ terminates communication, and allows these settings to be 
changed. 
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5. Protocol editing 
 

5.1 How to create a new protocol 
 
To create a new protocol, select File->New and select Protocol, as shown below: 
 

 
 
Then press OK, which will pop up the editor dialog: 
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Press the Add button to insert new steps.  New steps may be edited after they have been 
added (see below). 
 
Steps may be re-ordered, either individually or in groups, by selecting the steps to be re-
ordered, and using the Move Up and Move Down buttons. 
 
A single step or a group of steps may be cut, copied, or re-inserted, using the Cut, Copy, 
and Paste buttons – these work as most Windows users would expect, and the actions of 
the buttons may also be invoked by pressing <Ctrl-X>, <Ctrl-C>, and <Ctrl-V>, 
respectively. 
 
When a single step is selected (highlighted using the mouse or keyboard), the Volume 
after selected step indicator shows the volume in the syringe after the current step has 
been executed.  The volume at the beginning of the protocol is assumed to be the value in 
the Initial volume edit box.  The user may change the Initial volume, as desired. 
 
 

5.2 How to edit an existing protocol 
 
To edit a protocol, select Protocol->Edit to pop up the editor dialog, as described above.  
An example is shown below: 
 

 
 
See below for a description of creating and editing steps. 
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5.3 Create protocol step 
 
To create a new protocol step, press the Add button – this pops up the following dialog: 
 

 
 
Note: If no protocol step was selected in the editor dialog, then the new step is placed at 
the end of the protocol.  If any protocol steps were selected, then the new step is placed at 
the end of the selected steps.  The Move Up or Move Down button may be used to move 
the new step, if desired. 
 
Make sure to enter the correct values and units for the volume and rate, select the 
direction (intake/expel), the number of times to execute the step, and the post-step delay, 
if any.  Delay times are rounded to the nearest millisecond.  If a step is to be repeated, 
then the post-step delay is also repeated when executed. 
 
The Volume prior to this step indicator shows the calculated volume prior to the step 
being added.  This dialog will not allow the volume to exceed the capacity, and also 
checks the rate against the capacity (see Appendix C). 
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5.4 Edit protocol step 
 
To edit an existing protocol step, select the step in the editor window, and either double-
click on the step, or press the Edit button.  The protocol step dialog described above is 
then shown. 
 
 

5.5 Save protocol to file 
 
After a user presses OK in the editor window, the protocol is assumed to have been 
changed, and the app’s caption indicates this via an asterisk next to the title, as shown 
below: 
 

 
 
The asterisk means that there are changes to the protocol that have not been saved.  Select 
File->Save to save the changes back to the previous filename, or File->Save As to save 
changes to a new filename. 
 
Note that the app’s current capacity setting is also saved to the protocol file as a 
comment (see Appendix B). 
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6. Method editing 
 
The steps involved in creating and editing a method are similar to that for a protocol. 
 

6.1 How to create a new method 
 
To create a new method, select File->New and select Method, as shown below: 
 

 
 
Then press OK, which will pop up the editor dialog: 
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Press the Add button to insert new method steps.  New steps may be edited after they 
have been added (see below). 
 
Steps may be re-ordered, either individually or in groups, by selecting the steps to be re-
ordered, and using the Move Up and Move Down buttons. 
 
A single step or a group of steps may be cut, copied, or re-inserted, using the Cut, Copy, 
and Paste buttons – these work as most Windows users would expect, and the actions of 
the buttons may also be invoked by pressing <Ctrl-X>, <Ctrl-C>, and <Ctrl-V>, 
respectively. 
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6.2 How to edit an existing method 
 
Select Method->Edit to pop up the editor dialog.  An example is shown below: 
 

 
 
Note that the method shown above contains one of each of the six kinds of steps which 
may compose a method.   
 
See below for a description of creating and editing method steps. 
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6.3 Create method step 
 
To create a new method step, press the Add button.   
 
Note: If no method step was selected in the editor window, then the new step is placed at 
the end of the method.  If any steps were selected, then the new step is placed at the end 
of the selected steps.  The Move Up or Move Down button may be used to move the new 
step, if desired. 
 
Select the type of method step desired – this will cause the entry field(s) at the bottom of 
the dialog to change appearance as needed.  Enter the parameter needed, as follows: 
  
Execute:      executes a stored protocol, e.g. Capture 
 
Audible Alert:           introduces an audible alert at the end of an action 
 
Home (controller):   homes the 12 channel system to a zero volume 
 
Pause for Operator: builds in an automatic pause in the method 
 
Comment:                 allows operator to build in an automatic comment or prompt 
                                  between actions 
 
Blowout:                   causes a 12 channel system to blow out any air from the syringe 

  
 
The following method steps are auto controller instructions:  
 
Home Autocontroller: returns the robotics tower and 12 channel system to registered 
                                    Home position 
 
Down:                    moves the robotics tower with 12 channel system down to 
                               designated step position (0 is the highest position above the deck 
                                and 4725 is the position closest to the deck). 
 
Up:                           moves the robotics tower with 12 channel system up to the 

designated step position (0 is the highest position above the deck 
and 4725 is the position closest to the deck). 

 
External Pump:       operates an external pump (when fitted) via the rear serial port, 
                                 allowing for the automated addition of reagents.  
 
Rotate:   rotates the vertical 12 channel system. 
 
Position:                   moves the robotics tower with 12 channel system to the desired 
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                                 x-axis location on the deck. There are a total of 39,100 positions  
                                 along the x-axis. 
 
Position/Row           moves the robotic tower with 12 channel system to the desired  

Position (1-8) and specific Row (1-8).  This command assumes the 
use of plates that have 8 rows (e.g., standard 96 well plates, certain 
48 well plates, etc.). 

 
Load:                        loads a row of 12 PhyTip columns onto the 12 channel system 
 
Eject:                         ejects all 12 PhyTip columns from the 12 channel system 
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6.4 Edit method step 
 
To edit an existing method step, select the step in the editor window, and either double-
click on the step, or press the Edit button.  The method step dialog described above is 
then shown. 
 
 

6.5 Save method to file 
 
After a user presses OK in the editor window, the method is assumed to have been 
changed, and the app’s caption indicates this via an asterisk next to the title, as shown 
below: 
 

 
 
The asterisk means that there are changes to the method that have not been saved.  Select 
File->Save to save the changes back to the previous filename, or File->Save As to save 
changes to a new filename. 
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Appendix A : Protocol File Format 
 
Protocols are stored as simple text files, and may be edited with Notepad, if desired 
(however, this may result in a protocol which cannot be opened and/or verified by the 
app).  The app registers the file extension .psc for PhyNexus protocol files, so that 
clicking on a .psc file opens the protocol in the app (if the app isn’t already running). 
 
Each line of the file represents one step of the protocol, and is a comma-delimited list of 
the following fields : 
 

1. Volume, in mL - positive for intake, negative for expel. 
2. Rate, in mL per minute. 
3. Number of times to do the step - optional. 
4. Post-step delay, in seconds (app rounds this to nearest millisecond) – 

optional. 
 
For example, the following line indicates an expel step of 20 µL, with a rate of 5 µL per 
minute, done once: 
 
 -0.02,0.005 
 
The following line indicates an intake step of 1.5 mL, with a rate of 10 mL per minute, 
done three times : 
 
 1.5,10,3 
 
This line indicates an intake step of 0.5 mL, with a rate of 2 mL per minute, with a post-
step delay of 2 seconds : 
 
 0.5,2,1,2 
 
The line below indicates an intake step of 1.5 milliliters, with a rate of 10 milliliters per 
minute, done three times, each with a post-step delay of 1.5 seconds (if a step is to be 
repeated, then the post-step delay is also repeated when executed): 
 
 1.5,10,3,1.5 
 
Any line which begins with # is treated as a comment and ignored.  The app stores only 
one comment line to a file, to indicate the capacity in milliliters.  An example is as 
follows: 
 

# vol =1 
 
This indicates that when the file was saved, the app’s capacity setting was 1 mL. 
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Appendix B: Method File Format 
 
Methods are also stored as text files.  The app registers the file extension .pba for 
PhyNexus method files. Each line of a method file represents a step of the method, and 
may take the following forms: 
 

1. Execute specified protocol file : 
 

execute <protocol file path> 
 
For example, the following line indicates that the protocol file 
c:\protocols\test1.psc should be executed: 
 
execute c:\protocols\test1.psc 
 
Note that file paths may be absolute (as above) or relative.  Relative paths are 
relative to the app executable file.  For example, if the app resides at 
c:\phyNexus\pumpControl2.exe and the path protocols\test1.psc is specified, 
then the protocol file c:\phyNexus\protocols\test1.psc will be executed. 

 
2. Audible alert: 
 

alert 
 

3. Pause, show message, and wait for operator intervention: 
 

pause <message> 
 
The message is shown with OK and Cancel buttons.  OK continues the 
method, and Cancel terminates it.  New lines may be embedded in the 
message by inserting the “\n” escape sequence.  For example, the following 
line pops up a message box containing the lines “Hello” and “World”. 
 
pause Hello\nWorld 

 
4. Comment (ignored) : 

#<comment> 
 
Comments are ignored by the app when the method is executed, but can be 
useful for documenting methods. 

 
5. Home: 
 

home 
 

6. Blowout: 
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blowout 
 
The following method steps are provided as instructions to the auto controller: 
 

1. Home: 
 

auto_home 
 
2. Move tray to specified step: 

 
tray <step> 
 
The step must be between 0 and 39100. 

 
3. Move down towards tray specified number of steps: 
 

down <number of steps> 
 
The number of steps must be between than 0 and 4725. 

 
4. Load tips: 

 
load 

 
5. Move up to retracted position: 
 

up 
 
6. Eject tips: 

 
eject 

 
7. Turn external pump on/off: 
 

external_pump <on | off> 
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Appendix C: Flow rate limits 
 
Flow rates are limited to a range which is dependent on capacity, as indicated by the 
following table: 
 

Capacity Minimum flow rate Maximum flow rate 
200 µL 20 µL/min 17.1 mL/min 
1 mL 20 µL/min 85.7 mL/min 

1.2 mL 20 µL/min 102.9 mL/min 
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Appendix D: Flow rate implementation 
 
The 12 channel controller does not actually implement continuous flow rates, but 
operates at ten discrete motor speeds, each of which is computed as follows: 
 
 flow rate [mL/min] = 60 x syringe capacity [mL] / full-scale duration [sec] 
 
where the motor speed determines full-scale duration, as per the following table: (only 
the 200 and 1000 µL capacities are shown): 
 

Motor 
speed 

Full-scale duration 
[sec] 

Flow rate for 200 
µL capacity 
[mL/min] 

Flow rate for 1000 
µL capacity 
[mL/min] 

1 5.3 2.3 13.6 
2 4.5 2.7 16.0 
3 3.8 3.2 18.9 
4 3.2 3.8 22.5 
5 2.8 4.3 25.7 
6 2.4 5.0 30.0 
7 1.9 6.3 37.9 
8 1.5 8.0 48.0 
9 1.0 12.0 72.0 
10 0.7 17.1 102.9 

 
The motor speed used to implement a particular flow rate is usually arrived at by 
interpolating between the motor speeds.  For example, a flow rate of 13 mL/min for the 
200 µL capacity would use motor speed 9 because the midpoint between speeds 9 and 10 
is 14.6 mL/min. 
 
For flow rates below motor speed 1, the controller is commanded to perform move / wait 
cycles in which small intake or expel volume increments are made, interspersed by delays 
of several hundred to several thousand milliseconds.  These cycles are used when the 
flow rate falls below 2, 10, or 12 mL/min, for the 200 and 1000 µL capacities, 
respectively.  Motor speed 1 is used to perform the cycles.   
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The volume increments for move/wait cycles are as follows: 
 

 
Flow rate range [µL/min] Volume increment [µL] 

20 – 100 0.5 for 200 µL capacity, 1 
otherwise 

100 – 200 1 
200 – 400 2 
400 – 800 5 
800 – 1500 10 
1500 – 2000 15 
2000 – 4000 20 
4000 – 8000 40 
8000 – 12000 50 

 
The move/wait cycle delay is computed as follows: 
 
 delay [msec] = 60000 x volume increment [mL] / desired flow rate [mL/min] 
 
The number of cycles is simply the desired volume divided by the volume increment, 
rounded up so that at least one cycle is performed. 
 
For example, suppose a 100 µL intake step needs to be made at 300 µL/min.  In this case 
50 cycles will be performed, each withdrawing 2 µL at motor speed 1, with a 400 msec 
wait until the next cycle.  
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Appendix E: Registry Settings 
 
The app uses the Windows registry for storing settings from session to session.  The 
registry key for the app is as follows, and found under HKEY_CURRENT_USER, so 
that different users get different settings: 
 
Software\VB and VBA Program Settings\PhyNexus PumpControl 2 
 
Settings are stored under the following subkeys: 
 
Settings Subkey name 
Serial communications Serial 
Syringe settings Syringe 
MRU list MRU 
Browse directory (protocol and method) General 
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Cleaning Instructions 
 
To clean the exterior of this instrument, complete the following steps: 
 

a. Turn off and unplug the instrument 
b. Wipe the instrument exterior surfaces only, using a towel 

dampened with laboratory grade cleaning agent 
c. Repeat step b, using a towel dampened with clean water 
d. Repeat step c with a second water wash step 
e. Dry the instrument exterior using a dry towel 

 
Warning – do not allow any liquid to enter the instrument, or come in contact with any 
electrical components. The instrument must be thoroughly dry before you reconnect the 
power or turn the instrument on. 
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Safety Notices 
 
 
Warning – When cleaning instrument, do not allow any liquid to enter the instrument, or 
come in contact with any electrical components. The instrument must be thoroughly dry 
before you reconnect the power or turn the instrument on. 
 
Caution 
 
Power Cord Set Requirements 
 
The power cord set supplied with your instrument meets the requirements of the country 
where you purchased the instrument. If you use the instrument in another country, you 
must use a power cord set that meets the requirements of that country. 
 
To reduce the risk of fire hazard and electrical shock, do not expose the unit to rain or 
humidity. To reduce the risk of electrical shock, do not open or remove the instrument 
casing. All maintenance is to be performed by an authorized PhyNexus service provider. 
 
Warning 
 
This equipment is designed for connection to a grounded (earthed) outlet. The grounded 
type plug is an important safety feature. To reduce the risk of electrical shock or damage 
to the instrument, do not disable this feature. 
 
 
 
Environmental 
 

Operating Temperature:  4° to 30°C 
Relative Humidity   0% to 95% 
Altitude    0 to 10000 Ft 
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 AVERTISSEMENT 
TOUT CONTACT AVEC LES HAUTES TENSIONS PEUT ENTRAINER LA  
MORT OU DES BLESSURES SÉVÈRES.  CE PANNEAU NE DOIT ÊTRE 
ENLEVE QUE PAR UN RÉPARATEUR QUALIFIÉ.  

 
 AVERTISSEMENT 

TOUT CONTACT AVEC LES HAUTES TENSIONS PEUT ENTRAINER LA  
MORT OU DES BLESSURES SÉVÈRES.  CE PANNEAU NE DOIT ÊTRE 
ENLEVE QUE PAR UN RÉPARATEUR QUALIFIÉ.  

 
 AVERTISSEMENT 

TOUT CONTACT AVEC LES HAUTES TENSIONS PEUT ENTRAINER LA  
MORT OU DES BLESSURES SÉVÈRES.  CE PANNEAU NE DOIT ÊTRE 
ENLEVE QUE PAR UN RÉPARATEUR QUALIFIÉ.  
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WARNING 
If the MEA is used in a manner not specified by PhyNexus Inc, the 
protection provided the equipment may be impaired. 

 
 AVERTISSEMENT 

TOUT CONTACT AVEC LES HAUTES TENSIONS PEUT ENTRAINER LA  MORT 
OU DES BLESSURES SÉVÈRES.  CE 
 

 AVERTISSEMENT 
COURANT DE FUITE ÉLEVÉ — FORNIR UNE MISE À LA TERRE 
EFFICACE.  
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 

  WARNING 
 HIGH LEAKAGE CURRENT - 
 ENSURE PROPER GROUNDING 

MEA Power Supply Output: 
DC Voltage and Current 

 
24V 

3.33A 

MEA Power Supply Input: 
AC Voltage and Current 
100-240V ~ 
47-63Hz 1.9A 

WARNING 
Pollution Degree - 1 

Chiller Power Supply Input:
AC Voltage and Current 
100-240V ~ 
47-63Hz 1.9A 

Chiller Power Supply Output: 
DC Voltage and Current 

 
24V 

5.4 A 

Pipettor Power Supply Input:
AC Voltage and Current 
100-240V ~ 
47-63Hz 0.5A 
Output: 5VDC, 3.0A 



 

Version 1.7.8  Nov 8, 2005 
Copyright © 2005, PhyNexus, Inc., All Rights Reserved. 
 

75

MEA Personal Purification System Warranty 
 
 
The MEA Personal Purification System has a warranty period of one (1) year from the 
date of purchase. If the system should fail during the warranty period, please contact your 
local PhyNexus office for further instructions and information.  
 
Limited Warranty and Limitation of Liability 
 
Seller (PhyNexus) warrants the merchandise to conform to specifications.  Under no 
circumstances shall Seller be responsible for alleged nonconformities with respect to any 
merchandise which has been used for purposes or in any manner for which it was not 
intended, or any merchandise which has been customized or modified without Seller’s 
prior written consent, or damaged or misused.  As Buyer’s exclusive remedy in the event 
of breach of warranty, Seller shall repair or replace, as its option, any nonconforming 
merchandise or parts thereof for a period of one (1) year after delivery.  All claims must 
be made in writing to the Seller.  Any claims not made within the period specified above 
shall be deemed waived and released. 
 
THE PROVISIONS OF THE FOREGOING WARRANTIES ARE IN LIEU OF ANY 
OTHER WARRANTY, WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL 
(INCLUDING ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, TITLE OR NON-INFRINGEMENT).  SELLER’S 
LIABILITY ARISING OUT OF THE MANUFACTURE, SALE OR SUPPLYING OF 
A PRODUCT OR ITS USE OR ITS DISPOSITION, WHETHER BASED UPON 
WARRANTY CONTRACT, TORT OR OTHERWISE, SHALL NOT FOR ANY 
REASONS EXCEED THE AGGREGATE PURCHASE PRICE PAID BY BUYER FOR 
SUCH PRODUCT.  IN NO EVENT SHALL SELLER BE LIABLE TO BUYER OR 
ANY OTHER PERSON OR ENTITY FOR SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR EXEMPLARY DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA OR LOSS OF 
USE) ARISING OUT OF THE MANUFACTURE, SALE, SUPPLY, USE, 
MARKETING, RESALE OR OPERATION OF THE MERCHANDISE, EVEN IF 
SELLER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR 
LOSSES. 
 
 
PhyNexus, Inc.       Tel 408-267-7214 
 
 


